INSTRUCTION MANUAL

IP REMOTE CONTROL SOFTWARE

RS-BA1

FOREWORD

PRECAUTIONS

Thank you for purchasing the RS-BA1. The RS-BA1
is designed to remotely control an Icom radio through
a network.
This instruction manual contains detailed instructions
on how to configure your own remote control system.
Before reading this manual, please read the RS-BA1
Preparations and Installation guide q that come with
the RS-BA1, to install the software, and to connect a
radio to the Base station’s PC.

IMPORTANT! To remotely control radios using the
RS-BA1, BE SURE that you comply with your local
regulations.

IMPORTANT

Depending on your radio, a few functions or modes
cannot be used, or you will need to update the radio’s
firmware to operate the CW keyer, using the RS-BA1.

READ THIS INSTRUCTION MANUAL
CAREFULLY before attempting to configure the

Depending on the PC performance (OS, environment,
etc.), the USB audio may be interrupted, or a control
by the PC software may get delayed.

SAVE THIS INSTRUCTION MANUAL. This

If the CPU has a heavy load, the USB audio is easily
interrupted.

software.

instruction manual contains important safety and
operating instructions for the RS-BA1.

NOTE:
• This instruction manual based on RS-BA1 Version
1.0.
• In this manual, Microsoft® Windows® 7 Home Premium, Microsoft® Windows® 7 Professional, and
Microsoft® Windows® 7 Ultimate are described as
“Windows 7.”
		Microsoft® Windows Vista® Home Basic, Microsoft® Windows Vista® Home Premium, Microsoft®
Windows Vista® Business and Microsoft® Windows
Vista® Ultimate are described as “Windows Vista.”
		Microsoft® Windows® XP Professional and Microsoft® Windows® XP Home Edition are described
as “Windows XP.”

Icom, Icom Inc. and the Icom logo are registered trademarks of
Icom Incorporated (Japan) in Japan, the United States, the United
Kingdom, Germany, France, Spain, Russia and/or other countries.
Microsoft, Windows and Windows Vista are registered trademarks  
of Microsoft Corporation in the United States and/or other countries.
Adobe and Reader are registered trademarks of Adobe Systems
Incorporated in the United States and/or other countries.
All other products or brands are registered trademarks or trademarks of their respective holders.
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The RS-BA1 is designed to remotely control radios
that have a USB port (Type B).
RS-BA1 operation with the Base station’s PC connected to the radio’s ACC socket, MIC connector,
or S/P DIF jack for audio communication cannot be
guaranteed.

The settings of the installed audio player may be
changed after connecting a radio to the PC.
For the operation of PC and peripheral devices, follow
the instructions provided in the manuals which come
with the PC and peripheral devices.
All copyrights associated with this manual and all
intellectual property rights associated with the software of the RS-BA1 is held by Icom Inc.
Unauthorized reproduction or transmission of this
manual, or any part hereof, is prohibited.
The content of this manual and the software associated with the RS-BA1, and the appearance of the
RS-BA1 are all subject to change without notice.
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■ Overview of the RS-BA1
❍ The RS-BA1 consists of the Remote Utility, used to configure a remote control system, and the Remote Controller, used to send CI-V commands to a radio to remotely operate it.
❍ With the RS-BA1, you can configure a remote control system through the Internet, or a LAN.
❍ The RS-BA1 provides highly qualified audio communication between your PC and an Icom amateur radio through
a USB port (Type B)*.
* You can also control Icom radios using an RS-232C interface.

About the remote control system
An RS-BA1 remote control system consists of at least one PC, which is used as a Base station (Server) and at
least one PC, which is used as a Remote station (Client). Both PCs have to be connected with a network.
Radios are physically connected to the Base station, and the Remote station can operate the radios through the
network.
In the remote control system, CI-V commands, control commands such as “Connect” and “Disconnect,” and audio
are exchanged between a Base station and a Remote station, through their Remote Utilities.

Remote control system

Other station

Icom radio

Base station

Network

Remote station

Internet
through the Internet

through a LAN

LAN
* In this illustration, routers or other devices are not described.
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■ About the audio communication in the remote control system
In the remote control system, audio is exchanged between a radio which is connected to a Base station’s PC and
a speaker and a microphone which are connected to a Remote station’s PC, through Remote Utilities, as illustrated below.
In this column, the audio settings needed for the audio communication are described.
For detailed explanation, please refer to each reference page.

Remote
Utility
Radio

Network

Remote
Utility

VL

VL
Remote
Controller

Base station’s PC
：Received audio

：Transmit audio

Remote station’s PC

D Base station’s audio settings

D Remote station’s audio settings

Setting the PC

Setting the PC

Adjust the audio level of the audio device to which a
radio is physically connected. (pp. 4 to 6)

Adjust the audio level of the audio device to which
a speaker and a microphone, or a headset are connected. (pp. 4 to 6)

Settings in the Remote Utility
➥	Select an audio device to which a radio is physically
connected, for the audio communication between
the radio and the Base station’s PC. (p. 19)
➥	Limit the maximum level of the sound quality or audio
codec that Remote stations can adjust. (p. 19)

Settings in the Remote Utility
➥	Select an audio device to which a speaker and a
microphone, or a headset are connected, for the
audio communication through a network. (p. 25)
➥	Adjust the audio quality. (p. 24)
➥	Adjust the audio level of the received or transmit
audio. (p. 26)
• The Remote Utility’s AF audio level volume, and
the Remote Controller’s [AF] dial move simultaneously.
Settings in the Remote Controller
➥	To use transmit audio input from the PC, select a
radio’s connector which is connected to the Base
station’s PC. (p. 31)
➥	Adjust the input level from the selected connector.
(p. 31)

iv
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■ Firewall setting
The Windows operating system includes a Firewall setting as standard; this is the security function that can prevent
improper access through the Internet.
To let the Remote Utility work properly, add it as an exception in the Firewall.

Windows 7
q	Click [Control Panel] in the <Start> menu.
w	“Adjust your computer’s settings” appears, then
click [System and Security].

y	“Add a Program” appears, and click [Remote Utility]
and then [Add].

Click
q Click

e	Click [Allow a program through Windows Firewall].
w Click

u	Returns to “Allowed Programs.”
	In the “Allowed programs and features” list, check
that [Remote Utility] is displayed, and a check mark
is in the box, and then click [OK].

Click

r	“Allowed Programs” appears, then click [Change
settings].

Click

q Check

w Click

t	Click [Allow another program...].

Click

1

PREPARATION

1

Windows Vista
q	Click [Control Panel] in the <Start> menu.
w	Click [Security].

y	Click the [Exceptions] tab, and then click [Add program...].
q Click

Click

1
2

w Click

3

e	Click [Turn Windows Firewall on or off].

4

u	“Add a Program” appears, and click [Remote Utility]
and then [OK].

5
6

Click

7

r	If “User Account Control” appears, click [Continue].
t “Windows Firewall Settings” appears.
	If a check mark is inserted in “Block all incoming
connections,” click to remove it.

8

q Click

9
10

w Click

11

i	Returns to “Windows Firewall Settings” on the [Exceptions] tab.
	In the “Program or port” list, check that [Remote
Utility] is displayed, and a check mark is in the box,
and then click [OK].

12
13
14

Remove the check mark

15
16
17

q Check

18
19

w Click

20
21
2
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■ Firewall setting

Windows XP
q	Click [Control Panel] in the <Start> menu.
w	Double-click [Windows Firewall].

t	“Add a Program” appears, and then click [Remote
Utility] and then [OK].

q Click

Double-click

e	“Windows Firewall” appears.
	If a check mark is inserted in “Don’t allow exceptions,” click to remove it.

w Click

y	Returns to “Windows Firewall” on the [Exceptions]
tab.
	In the “Programs and Services” list, check that [Remote Utility] is displayed, and a check mark is in the
box, and then click [OK].

Remove the check mark

q Check

r	Click the [Exceptions] tab, and then click [Add Program...].
q Click

w Click

3

w Click
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■ Volume adjustment for audio device
Before you start communicating using the RS-BA1, the PC’s audio volume must be set to a proper level.
When several audio devices are used, you have to set each one individually.
• Configurable items, displayed screens and used terms differ, depending on your PC.
When your PC is used as a Base station
Adjust the audio level of the device that is connected to your radio.
The “Playback” setting is to adjust the modulation input level to the radio, and the “Recording” setting is to adjust the
received audio level from the radio.
Before adjusting, connect the radio and your PC, and turn ON the radio. (See the RS-BA1 Installation guide q that
comes with the RS-BA1.)

1

When your PC is used as a Remote station
Adjust the audio level of the device that your microphone, speaker or headset are connected to.
The “Playback” setting is to adjust the listening level of the speaker, and the “Recording” setting is to adjust the
transmit modulation level to the radio.

2
3
4

Windows 7/ Windows Vista
(This description is based on Windows 7.)
q	Right-click the speaker icon on the taskbar, and
click “Playback devices” or “Recording devices.”

w Click

5

e	“Speaker Properties” appears, and then confirm
“Use this device (enable)” is displayed in the Device Usage menu on the [General] tab.

6
7
8

q Click

9
10

q Right-click

w	“Sound” appears, and then click [Playback].
	Select an audio device that you will use, in the list
that appears, and then click [Properties].
q Click
w Select

11

w Check

12

r	Click the [Levels] tab.
	Adjust the speaker’s audio level by moving the slide
control to the right or left.
	After adjusting, click [OK] to close “Speaker Properties.”
• When the mute setting is turned ON in “Speakers”
( ), click the icon to turn OFF.

13
14
15
16

q Click

17

e Click

18
19

w Adjust

20

e Click

21
☞ Continued on the next page.
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■ Volume adjustment for audio device

Windows 7/ Windows Vista (Continued)
t	Click the [Recording] tab on “Sound.”
	Select an audio device that you will use, in the list
that appears, and then click [Properties].

q Click
w Select

i	Click the [Levels] tab.
	Adjust the microphone’s audio level by moving the
slide control to the right or left.
	After adjusting, click [OK] to close “Microphone
Properties.”
• When the mute setting is turned ON in “Microphone” ( ), click the icon to turn OFF.
• If you use the Windows Vista without any Service
Pack installed, and use “USB Audio CODEC” as
the audio device, the [Levels] tab’s sheet is not
displayed.
q Click

e Click

y “Microphone Properties” appears, and then confirm
“Use this device (enable)” is displayed in the Device Usage menu on the [General] tab.

w Adjust

e Click
q Click

w Check

u	Click the [Listen] tab.
	Confirm that a check mark is not inserted in “Listen
to this device.”
• If you use the Windows Vista, the [Listen] tab does
not appear.

q Click

w Check

e Click

5

NOTE:
If you use the Windows 7 and use “USB Audio
CODEC” as the audio device, set the audio level
to 2. Setting the level to 3 or higher can distort
the audio.
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Windows XP
q	Click [Control Panel] in the <Start> menu.
w	Click [Sounds, Speech, and Audio Devices].

w Click
q Adjust

1

Click

2
y	Return to the [Audio] tab in “Sounds and Audio Device Properties”.
	Select an audio device that you will use, in the Default device menu in the Sound recording.
When “USB Audio CODEC” is used:
[Volume...] is deactivated, and the recording audio
volume level cannot be changed.
When other than “USB Audio CODEC” is used:
Click [Volume...] to go to step u.

e	Click [Sounds and Audio Devices].

3
4
5
6
7

Click

r	“Sounds and Audio Device Properties” appears,
and then click the [Audio] tab.
	Select an audio device you will use, in the Default
device menu in the Sound playback, and then click
[Volume...].

8
9

Select

10
11

q Click

12

w Select

13
e Click

t	“Speaker” appears.
	To adjust the audio volume level, move the Speaker
bar that adjusts the whole audio volume level, and
move the Wave bar that adjusts the program’s audio
volume level, up or down.
• When the “Mute all” or “Mute” setting is turned ON
( ), remove all the check marks to turn OFF.

14

u	“Recording Control” appears.
	Insert a check mark in the “Select” box of the audio
control item, that audio data will be input into. Then
move the bar up or down to adjust the audio volume
level.
	After adjusting, click [ ] to close the screen.

15
16
17
18

e Click

19
20

w Adjust

21

q Select
6
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■ To allow access from the Internet
Only when you configure the remote control system through the Internet, you need the following settings on your
router.
If you configure the remote control system through the Internet, whether you are operating as a Base station or a
Remote station, you need to configure your router to allow access from the Internet.
Configure the port forwarding settings, and IP filter settings on your router, for port numbers 50001, 50002, and
50003.
Please refer to your router’s manual for details of how to configure the settings.

7
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■ Remote Utility’s screen description
Describes the Remote Utility’s screen contents.
Regarding the Remote Controller, see the chapter 4, “REMOTE CONTROLLER’S BASIC OPERATION.” (p. 28)

y[

]

q Setting Mode

t	Help Button

w Screen Tab

1
2
3
4

e Setting Screen

5
6
7
8

r	Setting Buttons

9
10
q Setting Mode
	Select either Radio Operation, Server Setting or
Network Setting mode, in the drop-down list.
w Screen Tab
Click a tab to select its setting screen.

Screen Contents
Setting Mode

Radio
Operation

e Setting Screen
Displays various settings you can make.
r	Setting Buttons
	Click to store the settings, open a different screen,
or for other functions.

User List
When you are configuring a Base station,
register users to allow them to access the
Base station.

y[ ]
	After clicking the button, move the “?” cursor over a
button or an item, then click to display its help window.

12

Radio List
Shows your accessible radios.
Server List
When you are configuring a Remote station (client), register Base stations (Server) to access.

t	Help Button
Click to open the Remote Utility help file.
	Pushing your keyboard’s [F1] key also opens the
file.

11

Description

Server
Setting

13
14
15
16
17

Radio List
When you are configuring a Base station,
register radios which are physically connected to your PC.

Network
Setting

Network
Configure your PC's network environment.

Common

About
Shows registration and production information, version number of the Remote
Utility and the drivers.

18
19
20
21
8

2

OPERATING AS A BASE STATION

■ To configure the remote control system through the Internet
If you configure the remote control system through the Internet, Remote stations can access the Base station using
its public IP address. If you utilize a Dynamic DNS service, Remote stations can access the Base station by not
only its public IP address, but also by its domain name.

D To let Remote stations access the Base station using its public IP address
A public IP address is an address that is accessible over the global Internet. If you use a dynamic public IP address,
it is chosen from a pool of available addresses and changes each time you connect to the Internet. Because of this,
Remote stations will have to match the IP address each time to access the Base station.
If you use a dynamic public IP address, we recommend that you utilize the Dynamic DNS service to allow the Remote stations to access the Base station using its domain name, or use a static public IP address.
Please refer to your router’s manual for details of how to configure your router to set the public IP address.

Internet
IP address
WAN
: ���.���.���.���
LAN
: 192.168.0.1

Router

Base station

Router

Remote station

Icom radio
IP address
: 192.168.0.100
Computer name : BasePC

9

Request “���.���.���.���”
(Public IP address)
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D To let Remote stations access the Base station by its domain name
If you set up an account for a Dynamic DNS server, you can configure your router to update the Dynamic DNS
server with your dynamically changing IP address. Even if you don’t have a static public IP address, you can allow
Remote stations to access the Base station through the Internet, using its domain name.
Please refer to your router’s manual for details of how to configure your router to use the Dynamic DNS services.

Dynamic DNS
server

1

Update with your dynamically
changing IP address
IP address
WAN
: ���.���.���.���
LAN
: 192.168.0.1
Domain name
Icom-rsba1.com

2

Internet

3

Router

Router

4
5
6

Base station

Remote station

7
8

Icom radio
IP address
: 192.168.0.100
Computer name : BasePC

Request “Icom-rsba1.com”
(Domain name)

9
10
11
12
13
14
15
16
17
18
19
20
21
10
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■ To configure the remote control system through a LAN
If you configure the remote control system through a LAN, Remote stations can access the Base station using its
computer name or IP address.
This column describes how to find out the Base station’s computer name, or IP address, to be requested by Remote stations, with an example illustrated below.

Router
Remote station

Base station

Icom radio
IP address
: 192.168.0.10
Computer name : BasePC

Request “192.168.0.10” (IP address)
or “BasePC” (Computer name)

D To let Remote stations access the Base station using its computer name
A computer name is used on networks to identify a particular workstation on the network.
Find out your PC’s computer name to let Remote stations access the Base station using it.

Windows 7/ Windows Vista

Windows XP

(This description is based on Windows 7.)
q Right-click [Computer] in the <Start> menu, and
then click [Properties].

q Right-click [My Computer] in the <Start> menu, and
then click [Properties].
w Right-click

w Right-click

e Click

e Click

q Click

q Click

w “System” appears, and then check the name which
is displayed in the Computer name field.

w “System Properties” appears, and then click the
[Computer Name] tab.
Check the name which is displayed in the Full computer name field.

q Click
Check

11

w Check
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D To let Remote stations access the Base station using its IP address
An IP address is a numerical label that is assigned to devices participating in a computer network.
Find out your PC’s IP address to let Remote stations access the Base station using it.

Windows 7
q Right-click the Network icon on the taskbar, and
then click [Open Network and Sharing Center].
w Click

r “Network Connection Details” appears, then check
an IP address which is displayed in the Address
field.
Click [Close] to close the window.

1
2

q Right-click

w “Network and Sharing Center” appears, then click
[Local Area Connection].

3

q Check

4
5
w Click

Click

e “Local Area Connection Status” appears, then click
[Details...].

When the DHCP Enabled field reads “Yes” in the
“Network Connection Details” window, the DHCP
server assigns a dynamic changing IP address
to your PC.
Because of this, Remote stations will have to
match the IP address each time to access the
Base station.
If the DHCP Enabled field reads “Yes,” we recommend that you let Remote stations access the
Base station using its computer name. (p. 11)

6
7
8
9
10
11
12
13

Click

14
15
16
17
18
19
20
21
12

2

OPERATING AS A BASE STATION

■ To configure the remote control system through a LAN
D To let Remote stations access the Base station using its IP address (continued)

Windows Vista
q Right-click [Computer] in the <Start> menu, and
then click [Properties].
w Right-click

q Click

e Click

r “Network Connection Details” appears, then check
an IP address which is displayed in the IP Address
field.
Click [Close] to close the window.

q Check

w “Network and Sharing Center” appears, then click
[View status].
w Click

Click

e “Local Area Connection Status” appears, then click
[Details...].

Click

13

When the DHCP Enabled field reads “Yes” in the
“Network Connection Details” window, the DHCP
server assigns a dynamic changing IP address
to your PC.
Because of this, Remote stations will have to
match the IP address each time to access the
Base station.
If the DHCP Enabled field reads “Yes,” we recommend that you let Remote stations access the
Base station using its computer name. (p. 11)
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Windows XP
q	Right-click [My Network Places] in the <Start>
menu, and then click [Properties].
w Right-click

e Click
q Click

 hen the Address Type field reads “Assigned
W
by DHCP” in the “Local Area Connection Status”
window, the DHCP server assigns a dynamic
changing IP address to your PC.
Because of this, Remote stations will have to
match the IP address each time to access the
Base station.
If the Address Type field reads “Assigned by
DHCP,” we recommend that you let Remote stations access the Base station using its computer
name. (p. 11)

1
2
3

w	“Network Connections” appears.
	Right-click [Local Area Connection], and then click
[Status].

4
5
6
7
8

q Right-click
w Click

9
10

e	“Local Area Connection Status” appears, then click
the [Support] tab.
	Check an IP address which is displayed in the IP
Address field, and then click [Close] to close the
window.
q Click

11
12
13
14
15
16

w Check

17
18
19
20
e Click

21
14
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■ Network setting
Configure your PC’s network environment in the Remote Utility.
The settings will take effect after rebooting the Remote Utility.
When you first open the Remote Utility, the Network Setting screen appears.
After configuring your network environment, you can display other setting screens.
q	In the Remote Utility, select the Network Setting
mode. Then, click [Network] tab to display the Network screen.
w	Enter a name for your PC in the PC Name field, of
up to 16 characters.
	DO NOT set the same name to more than one PC
on your network.
e	Check the port numbers of the Control, Serial and
Audio ports.
	You should use the default port numbers for these
ports.
r	Select your internet access line type in the Internet
Access Line menu.
t	Click [Apply] to save the network settings.
	After clicking, the “Take effect after restarting the
application” screen appears, then click [OK].
	The settings will take effect after rebooting the Remote Utility.
NOTE:
If you configure the remote control system through
the Internet, and change the port number of the
Control, Serial or Audio port, you should configure
the port forwarding settings and the IP filter settings
on your router once again. (p. 7)

15

q Enter
w Check
e Select
r Click

Click
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■ User registration
In the Remote Utility, register users to allow them to access the Base station.
The Base station verifies the user ID and password when Remote stations attempt to access the Base station. If
the User ID or password is incorrect, the Remote station cannot access the Base station.

D To register a user
q	In the Remote Utility, select the Server Setting
mode. Then, click the [User List] tab to display the
User List screen.
w	Enter a user ID in the User ID field, of up to 16
characters, case-sensitive.
	You cannot register an already registered ID.
e	Enter a password in the Password field, of 8 to 16
characters, case-sensitive.
At least two different characters must be used.
r	To set the user as an administrator, click the Administrator box to insert a check mark.
	Administrator Remote stations can terminate a
connection between another Remote station and a
radio. (p. 20)
t	Click [Add] to save the settings.
	After clicking, the User Registration screen appears.
Select radios which you allow the Remote station to
use.
	After selecting, click [OK] to save the settings and
close the screen.
NOTE:
• To remove a Remote station from the User List,
select its user ID, and then click [Remove].
		The Remote station will not be able to access the
Base station.
• If you select radios to allow a Remote station to
use in the User Registration screen, the Remote
station’s user ID is automatically registered in the
radio’s Permitted Users list. (p. 18)

q Enter

w Enter

1
e Click

2
3
4
5
6
7
8
9
10

q Select

11
12
w Click

13
14

To prevent unauthorized access:
Set a long and strong password so that no one can
possibly guess it.
Mix upper and lower case letters, numbers or characters.

15
16
17
18
19
20
21
16
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■ Radio registration
In the Remote Utility, register the radios which are physically connected to your PC.
Please read the RS-BA1 Installation guide q, to connect a radio to your PC.
• Radio Registration screen

DRadio’s basic information

DCOM port and audio

setting (p. 18)

device setting (p. 19)

DRadio’s Remote station

registration (p. 18)

DAdjust limitation setting

(p. 19)

D To register a radio
Procedure
Step 1:
Open the Radio Registration screen
Server Setting mode � Radio List screen � [Add]

Step 4:
Limit the maximum level of the Remote station’s audio quality
adjustment
DAdjust limitation setting (p. 19)

Step 2:
Configure the radio’s basic information
DRadio’s basic information setting (p. 18)

Step 5:
Set the COM port and audio devices
DCOM port and audio device setting (p. 19)

Step 3:
Register remote stations to allow them to access the radio
DRadio’s Remote station registration (p. 18)

Step 6:
Save the settings
Radio Registration screen � [OK]

NOTE:
To remove a radio from the Radio List screen, select
it in the list, and then click [Remove].
		

17
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D Radio’s basic information setting

D Radio’s Remote station registration

q	In the Remote Utility, select the Server Setting
mode. Then, click the [Radio List] tab to display the
Radio List screen.
w	C lick [Add] to display the Radio Registration
screen.
e	Enter a name for the radio in the Radio Name field,
of up to 16 characters.
r	Check a check mark in the CI-V box, and then enter
the radio’s CI-V address in the Address field.
t	Select the radio’s baud rate in the Baud Rate
menu.
y	Click the Public box to insert a check mark.
u	C lick [OK] to save the settings, and close the
screen.

Of the Remote stations that can access the Base station, you can select Remote stations to allow them to
access the radio.
q	In the Remote Utility, select the Server Setting
mode. Then, click the [Radio List] tab to display the
Radio List screen.
w	Select a radio, and then click [Properties] to display
the Radio Registration screen.
e	Click [User Permission].

2
3
Click

q Enter
w Enter
e Insert a check mark

NOTE:
• Be sure to set the same CI-V address and the
baud rate that are programmed into the radio.
		If the radio’s baud rate is set to “Auto,” select
“19200” in the Baud Rate menu.
		See the radio’s instruction manual for details on
how to confirm the radio’s CI-V address and baud
rate, or how to change them.
• To not allow Remote stations to access a radio,
remove the check mark from the Public box.

1

r	The Radio User Permission screen appears.
	Select Remote stations in the Registered Users
list, and then click [Permit].
	Check the selected Remote stations are displayed
in the Permitted Users list, and then click [OK] to
close the screen.

q Select

e Check

w Click

4
5
6
7
8
9
10
11

r Click

t	Click [OK] in the Radio Registration screen to save
the settings and close the screen.
NOTE:
• To remove a Remote station from the Permitted
Users list, select it in the list, and then click [Inhibit].
• When you newly register a Remote station, you
can select radios in the User Registration screen,
to allow the Remote station to use them. (p. 16)
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■ Radio registration

D Adjust limitation setting

D COM port and audio device settings

Remote stations can adjust the sound quality or audio
codec. Higher audio qualities will increase the amount
of data, which may overload the Base station’s PC,
and may influence other application on the PC.
The Base station can limit the maximum level of the
sound quality or audio codec.
Remote stations cannot program higher values than
the values programmed here.

Set the COM port which is used to transmit CI-V commands, or audio devices which are used for the audio
communication.
The explanation is based on when you connect a radio
to your PC using a USB cable.
After connecting and turning ON the radio, make the
following settings.

q	In the Remote Utility, select the Server Setting
mode. Then, click the [Radio List] tab to display the
Radio List screen.
w	Select a radio, and then click [Properties] to display
the Radio Registration screen.
e	Check that a check mark is in the AF - Use and
MOD-Use box.
r	Limit the received or transmit audio sampling rate
that Remote stations can adjust, in the Sample
Rates bar.
	Higher sampling rates will improve the audio quality. However, they also increase the amount of data,
which can cause voice delay or jumpiness, depending on the network condition.
Lower sampling rates will decrease the audio quality.
However, they also decrease the amount of data.
t	Limit the received or transmit audio codec that Remote stations can adjust, in the Codecs bar.
y	Select whether or not to allow Remote stations to
select stereo sound, in the Channels bar.
	When you select “1 ch” (monaural), Remote stations cannot program “2 ch” (stereo).
u	C lick [OK] to save the settings and close the
screen.

q	In the Remote Utility, select the Server Setting
mode. Then, click the [Radio List] tab to display the
Radio List screen.
w	Select a radio, and then click [Properties] to display
the Radio Registration screen.
e	Click the COM Port/Audio Setting - Auto radio
button.
	Radios which are connected to your PC using a
USB cable are displayed in the drop-down list.
	Select an appropriate one from the list, then the
COM port and audio device are automatically set.
r	C lick [OK] to save the settings and close the
screen.

w Select
q Click

q Check

w Adjust
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NOTE:
When you physically connect a radio to your PC
using other than a USB cable, select “Manual.”
In this case, you should manually select a COM port
to which the radio is connected in the COM Port
Number menu.
You should also select an appropriate audio device
to which the radio is connected in the AF Input Device and MOD Output Device menus.
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■ To monitor, or disconnect a Remote station
When you are operating as a Base station, and a Remote station is accessing a radio which is physically connected
to your PC, you can monitor the received and transmitted audio.
• To monitor, you should connect a speaker to your PC.
Moreover, you can terminate the connection between the Remote station and the radio.
Besides Base stations, administrator Remote stations can also terminate a connection between another Remote
station and a radio.

D To monitor the received or transmitted
audio
q	In the Remote Utility, select the Radio Operation
mode. Then, click the [Radio List] tab to display the
Radio List screen.
w	Select a radio with “Busy” under its name, and then
click [Monitor].
	The operating user’s name (PC Name that the Remote station set in the Network Setting screen), and
its IP address are displayed under “Busy.”
e	The Monitor screen appears.
	Click [TX Monitor] to turn the Transmit Monitor function ON or OFF.
	Click [RX Monitor] to turn the Receive Monitor function ON or OFF.
	Slide the adjustment bar on the Volume field up or
down to adjust the monitoring audio volume level.
r	Click [Close] to close the screen.

q Click
w Adjust

D To terminate a connection
q	In the Remote Utility, select the Radio Operation
mode. Then, click the [Radio List] tab to display the
Radio List screen.
w	Select a radio with “Busy” under its name, and then
click [Disconnect].
	The operating user’s name (PC Name that the Remote station set in the Network Setting screen), and
its IP address are displayed under “Busy.”
e	“The radio is in use by a client. Do you want to disconnect?” appears. Click [Yes] to terminate the connection.

1
2
3
4
5
6

Click

7
8

NOTE:
Even if you terminate a connection, no dialog appears on the disconnected Remote station’s Remote Utility.

9
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e Click
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■ Connecting a Base station to a radio
When you are operating as a Base station, you can access a radio which is physically connected to your PC
through a network.
• For audio communication, you should connect a speaker and microphone, or headset to your PC.
• To control the radio, connect to it using a control software.

D Connecting to a radio

D Disconnecting from a radio

q	In the Remote Utility, select the Radio Operation
mode. Then, click the [Radio List] tab to display the
Radio List screen.
w	Select a radio, and then click [Settings] to display
the Connection Setting screen.
e	Select an audio device in the AF Output Device
menu to which your speaker is connected.
	Radio’s received audio will be output from the device.
r	Select an audio device in the MOD Input Device
menu to which your microphone is connected.
	You can input transmit audio in the device to transmit to the radio.
t	Click [Connect].

q	In the Remote Utility, select the Radio Operation
mode. Then, click the [Radio List] tab to display the
Radio List screen.
w	Select a radio with “<<CONNECT>>” under its
name, and then click [Disconnect].
e	“Do you want to disconnect the radio?” appears.
Click [Yes] to disconnect the radio.

q Select
w Select
e Click

y	A dialog showing a port number, which is used to
exchange CI-V commands between your PC and a
radio, appears.
	Click [OK] to save the settings and access the
radio.
• “<<CONNECT>>” appears under the radio name
when the connection has succeeded.

Click

• When you connect to the radio using a control
software, you have to set the port number.
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Click

NOTE:
Be sure to disconnect from the radio when not using
the radio. Otherwise, other Remote stations cannot
connect to it.
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■ Network setting
Configure your PC’s network environment in the Remote Utility.
The settings will take effect after rebooting the Remote Utility.
When you first open the Remote Utility, the Network Setting screen appears.
After configuring your network environment, you can open other setting screens.
q	In the Remote Utility, select the Network Setting
mode. Then, click [Network] tab to open the Network screen.
w	Enter a name for your PC in the PC Name field, of
up to 16 characters.
	DO NOT set the same name to more than one PC
on your network.
e	Check the port numbers of the Control, Serial and
Audio ports.
	You should use the default port numbers for these
ports.
r	Select your internet access line type in the Internet
Access Line menu.
t	Click [Apply] to save the network settings.
	After clicking, the “Take effect after restarting the
application” screen appears, then click [OK].
	The settings will take effect after rebooting the Remote Utility.
NOTE:
If you configure the remote control system through
the Internet, and change the port number of the
Control, Serial or Audio port, you should configure
the port forwarding settings and the IP filter settings
on your router once again. (p. 7)

q Enter
w Check
e Select

1
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3

r Click
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Click
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■ Connecting to a Base station
To connect to a radio through the network, Remote stations should first use the Remote Utility to connect to a Base
station to which the radio is connected.
Before connecting, register the Base station information.

D Base station registration

D Connecting to a Base station

Before registering the Base station information, be
sure to confirm the following data;
• IP address, domain name or computer name of the
Base station’s PC. (pp. 9 to 14)
• Your user ID and password, which are registered in
the Base station’s Remote Utility. (p. 16)

q	In the Remote Utility, select the Radio Operation
mode. Then, click the [Server List] tab to display the
Server List screen.
w	Select a Base station, then click [Connect].

q	In the Remote Utility, select the Radio Operation
mode. Then, click the [Server List] tab to display the
Server List screen.
w	C lick [Add] to display the Server Registration
screen.
e	Enter a name for the Base station in the Server Description field.
r	Enter the IP address, domain name or computer
name of the Base station’s PC in the Server Address or Computer Name field.
t	Enter your user ID and password which are registered in the Base station, in the User ID and Password fields.
y	Click [OK] to save the data, then close the screen.

If the connection fails, and an error screen is displayed, solve the problem using the Troubleshooting section. (p. 32)

q

Enter

w

Enter

e

Enter

r

Click

NOTE: To remove a Base station from the Server
List, select it in the list, then click [Delete].
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• “CONNECTING” appears under the Base station name
when the connection has succeeded.

D Disconnecting from a Base station
q	In the Remote Utility, select the Radio Operation
mode. Then, click the [Server List] tab to display the
Server List screen.
w	Select the Base station with “CONNECTING” under
its name, then click [Disconnect].
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■ Connecting to a radio
When the connection to the Base station has succeeded, the radios which are physically connected to the Base
station are displayed on the Radio List screen.
Select a radio from the list, then connect to it through the network using the Remote Utility.
You have to configure the network audio quality and devices to connect.
• To control the radio, connect to the radio using the Control software.

D Connecting to a radio

D Network audio quality setting

Procedure

q	In the Remote Utility, select the Radio Operation
mode. Then, click [Radio List] tab to display the
Radio List screen.
w	Select a radio, then click [Settings] to display the
Connection Setting screen.
e	Click [Recommended].

Step 1:
Display the Connection Setting screen
Radio Operation mode � Radio List Screen (select a radio)
� [Settings]

Set the network audio quality
D Network audio quality setting

Click

Step 3:
Select a virtual COM port number and an audio device

r	The Select Network screen appears.
	Select the connection to a radio either through a
LAN, or the Internet, and then click [Next].

Step 4:

4
5
6
7
8

Save the settings, and connect to the radio
Connection Setting screen→[Connect]

2
3

Step 2:

D Device setting (p. 25)

1

q

9

Select

10
NOTE:
• If the connection setting is finished, you can simply connect to the radio by selecting it in the Radio
List screen and then clicking [Connect].
• “<<CONNECT>>” appears under the radio name when
the connection has succeeded.

• If the connection fails, and an error screen is displayed, solve the problem using the Troubleshooting section. (p. 33)

w

Click

t	The recommended values for your network are
displayed. Click [Yes] to automatically set the displayed values in each field of the Network Setting,
then close the Select Network screen.

11
12
13
14
15
16

Click

17
18

y	Click [Save] in the Connection Setting screen to
save the settings, and close the screen.
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■ Connecting to a radio

D Device setting

D Disconnecting from a radio

q	In the Remote Utility, select the Radio Operation
mode. Then, click [Radio List] tab to display the
“Radio List” screen.
w	Select a radio, then click [Settings] to display the
Connection Setting screen.
e	Select a COM port number in the Virtual COM Port
Number menu.

q	In the Remote Utility, select the Radio Operation
mode. Then, click [Radio List] tab to display the
Radio List screen.
w	Select a radio with “<<CONNECT>>” under its name,
and click [Disconnect].
e	“Do you want to disconnect the radio?” appears.
Click [Yes] to disconnect the radio.

• The selected COM port number is used for CI-V operation with the radio.

 hen you connect to the radio with a control
W
software, you have to set the COM port number.
r	Select an audio device in the AF Output Device
menu to which your speaker is connected, to output
the received audio from the network.
t	Select an audio device in the MOD Input Device
menu to which your microphone is connected, to
transmit the input audio to the network.
y	Click [Save] to save the settings, and close the
screen.

q

Select

w

25

Click

Click

NOTE:
• Be sure to disconnect when not using the radio.
Otherwise, other Remote stations cannot connect
to it.
• The Base station or administrator Remote stations
can terminate a connection between another Remote station and a radio. If “<<CONNECT>>” disappears while connecting to a radio, the Base station
or authorized Remote station may terminate the
connection.
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■ Audio adjustment using the Remote Utility
While connected to a radio, you can adjust the received and transmit audio volume through the network using the
Remote Utility.
The description on this section is based on the assumption that the connection to the radio has succeeded
(“<<CONNECT>>” is displayed under the radio name).

D Received audio volume adjustment

D Transmit audio volume adjustment

q	In the Remote Utility, select the Radio Operation
mode. Then, click [Radio List] tab to display the
Radio List screen.
w	Select a radio with “<<CONNECT>>” under its name,
and click [AF].
e	Slide the adjustment bar on the Volume field up or
down to adjust the received audio volume level.

q	In the Remote Utility, select the Radio Operation
mode. Then, click [Radio List] tab to display the
Radio List screen.
w	Select a radio with “<<CONNECT>>” under its name,
and click [MOD].
e	Select “Mic” on the MOD Select field.
r Slide the adjustment bar on the Volume field up or
down to adjust the transmit audio volume level.
t	Click [Close] to close the screen.

• Click [Mute] to mute the audio, and click once again to
hear the audio.

r	Click [Close] to close the screen.

q

Select

1
2
3
4
5
6
7

e
q

Adjust

w

Click

NOTE:
• The AF adjustment bar on the Volume field moves
together with the [AF] control of the Remote Controller. However, if you use another control software, the audio volume level on the network can
only be adjusted with the Remote Utility.
• You cannot adjust the received audio volume level
of the radio’s speaker, with the Remote Utility. Use
the [AF] control on the radio to adjust it.

w

Click

Adjust

8
9

NOTE:
You cannot adjust the modulation input level of the
radio, with the Remote Utility. Adjust the modulation
input level of the radio in the radio’s Set mode, or
using the Remote Controller. (p. 31)
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■ Recording and playback functions
While connected to a radio, you can record the received audio, and save it into the PC’s hard disc, using the Remote Utility.
Also, you can transmit an audio file to the radio, using the Remote Utility.
The description on this section is based on the assumption that the connection to the radio has succeeded
(“<<CONNECT>>” is displayed under the radio name).

D Recording a received audio

D Playing back/transmitting an audio file

Follow the steps below to record the received audio.

Follow the steps below to play back/transmit an audio
file.

q	In the Remote Utility, select the Radio Operation
mode. Then, click [Radio List] tab to display the
Radio List screen.
w	Select a radio with “<<CONNECT>>” under its name,
and click [AF].
e	Click [
] to start recording.
• While recording, click [

r	Click [

] to pause.

] to stop recording.
Record button
Stop button
Pause button

q	In the Remote Utility, select the Radio Operation
mode. Then, click [Radio List] tab to display the
Radio List screen.
w	Select a radio with “<<CONNECT>>” under its name,
and click [MOD].
e	Select “File” on the MOD Select field.
r	Click [Open] to select an audio file* to play or transmit.
* Only uncompressed, linear, PCM WAV files are supported.

t	Click [

] to start playing/transmitting.

• While playing/transmitting, click [

y	Click [
Open the folder
Recording file
name
Elapsed time

Recording folder name

Folder browse button

NOTE:
• When you click [Folder Open], the folder in which
the recording file is stored will be displayed.
• If you want to change the recording folder, click
the [
] button, then select a folder in the
Browse For Folder screen.
• Adjust the sample rate frequency and codec to
record the audio according to the recording purpose. When you record the received audio from
the network, we recommend that you set the same
sample rate frequency and codec that are programmed in the Connection Setting screen.
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] to pause.

] to stop playing/transmitting.
Playback button
Stop button
Pause button

Open the folder
Audio file name
Elapsed time

NOTE:
You can also use the Remote Controller’s Voice
Memory function to play back or transmit an audio
file.
See the Remote Controller’s help file for details.
To display the help file, click “Contents” in the Help
menu on the Remote Controller, or push the [F1]
key on your PC’s keyboard.
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■ Connecting to a radio with the Remote Controller
This chapter describes how to connect to a radio and remotely control it using the Remote Controller.
There are two ways to connect to the radio with the Remote Controller:
1. Connecting to the radio through a network using the Remote Utility (p. 29)
2. Directly connecting to the radio that is physically connected to your PC, instead of using the Remote Utility (p. 30)

Connects to the radio (pp. 29, 30)
D About the Remote mode (p. 31)
Displays the Connect Setting screen (pp. 29, 30)

1
2
3
4
5
6
7
8
9
10
11

D To use transmit audio input from the PC (p. 31)

NOTE:
See the RS-BA1 Remote Controller’s help file for remote operation details, such as how to change the frequency, or turn ON each function.
To display the help file, click “Contents” in the Help menu on the Remote Controller, or push the [F1] key on your
PC’s keyboard.
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■ Connecting to a radio with the Remote Controller

D Connecting to a radio through a network
To connect to a radio through a network using the Remote Controller, first you have to access the radio using the
Remote Utility.
To connect the radio using the Remote Utility, see page 21 when you are operating as a Base station, or see page 24
when you are operating as a Remote station.
q	Open the Remote Controller.
w	Click the right icon in the toolbar, or click
“Connect Setting...” in the [Option] menu, to
display the Connect Setting screen.
e	Select a radio that you want to control in the Model
menu.

q Select
w Select

• The items, buttons or dials that cannot be used in the
selected model will be grayed out.

r	Select a radio that you are accessing with the Remote Utility, in the Remote Utility menu.
• The CI-V settings are automatically loaded from the
Remote Utility to the CI-V field. The settings include
the virtual COM Port number, radio’s CI-V address and
baud rate and the virtual audio device for the Voice
Memory function.
If the desired radio is not displayed in the Remote
Utility menu, click [Search] to load the radios’ information from the Remote Utility.

t	Click [OK] to save the settings, and close the Connect Setting screen.
y	Click the right icon in the toolbar, or click
“Connect ON” in the [File] menu, to connect
to the radio.
• When the connection has succeeded, the radio’s current data will be displayed on the main panel.
• If the connection fails, and an error screen is displayed,
solve the problem using the Troubleshooting section.
(p. 34)
• To disconnect from the radio, click the right
icon, or click “Connect OFF” in the [File] menu.
• Even if you disconnect from the radio, it does
not turn OFF the radio.
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e Click

REMOTE CONTROLLER'S BASIC OPERATION

4

D Directly connecting to a radio
If a radio is physically connected to your PC, you can directly access the radio using the Remote Controller, instead
of using the Remote Utility.
• When you are operating a radio on the remote control system with the Remote Controller, without having used the
Remote Utility to connect, let other users know that the radio is being used.
q	Open the Remote Controller.
w	Click the right icon in the toolbar, or click
“Connect Setting...” in [Option] menu, to display the Connect Setting screen.
e	Select a radio that you want to control in the Model
menu.

q Select
w Select

1

• The items, buttons or dials that cannot be used in the
selected model will be grayed out.

2

r	Select “Not Use” in the Remote Utility menu.
t	Select the COM port number to which the radio is
connected, in the COM Port menu.
y Enter the radio’s CI-V address in the CI-V address
(Radio) field, and select the radio’s baud rate in the
Baud rate (bps) menu.
	If the radio’s baud rate is set to “Auto,” select “19200”
in the Baud Rate (bps) menu.

3
e Enter

5
6

• To check or change the radio’s CI-V address and baud
rate settings, see the instruction manual that comes
with the radio.

u	Click [OK] to save the settings, and close the Connect Setting screen.
i	Click the right icon in the toolbar, or click
“Connect ON” in the [File] menu, and connect to the radio.
• When the connection has succeeded, the radio’s current data will be displayed on the main panel.
• If the connection fails, and an error screen is displayed,
solve the problem using the Troubleshooting section.
(p. 34)
• To disconnect from the radio, click the right
icon, or click “Connect OFF” in the [File] menu.
• Even if you disconnect from the radio, it does
not turn OFF the radio.
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■ Connecting to a radio with the Remote Controller

D To use transmit audio input from the PC

D About the Remote mode

In order to use transmit audio input when remotely
controlling the radio from the Remote Controller, configure the following settings, depending on the radio’s
connector which is connected to a PC.
When you are operating as a Remote station, check
the radio’s connector which is connected to the Base
station’s PC.

When connected to the radio, the Remote Controller
automatically turns ON the Remote mode.
While the Remote mode is ON, the Remote Controller
transmits CI-V commands not only to check the radio’s
current state, but also to remotely control it.
When you want the Remote Controller to only check
the radio’s current state, or when you want to inhibit
the Remote Controller from transmitting CI-V commands, while you manually operate the radio, turn
OFF the Remote mode.

q	Connect to a radio with the Remote Controller.
(pp. 29, 30)
w	Click [MIC SET] to open the MIC SET screen.
e	Select an appropriate connector in the MOD Select
(Remote ON) menu, to input transmit audio from
the PC to the radio.
	The options differ, depending on the radio selected
in the Model menu in the Connect Setting screen.
• Right click [MOD LEVEL] to rotate clockwise, or left click
it to rotate counterclockwise, to adjust the input level
from the connector.

r	Click [

] to close the screen.
e Click

q Select

w Adjust
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To turn OFF the Remote mode
Click the right icon on the toolbar, or click “Remote OFF” in the [File] menu.
To turn ON the Remote mode
Click the right icon on the toolbar, or click “Remote ON” in the [File] menu.
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The following descriptions are possible causes and solutions for the problem you are experiencing.
If you cannot solve the problem after trying these solutions, please contact your nearest Icom Dealer or Service
Center.
Problem: Cannot access a Base station from a Remote station with the Remote Utility
You can configure the Base station information in the Server Registration screen (Radio Operation mode ➔
Server List screen ➔ [Add] or [Properties]).
❍ “CONNECT NG” is displayed under the Base station name
		
Possible cause 1
			An incorrect IP address, domain name or computer name is entered to request a connection to the Base station.
			 If the Remote Utility cannot find out the Base station’s IP address using the domain
name or computer name that you entered, “Cannot resolve the name” is displayed
“CONNECT NG”
next to the name.
			
Solution
q Check the Base station’s IP address, domain name or computer name. (pp. 9 to 14)
			
w Enter the Base station’s correct IP address, domain name or computer name in the
Server Address or Computer Name field in the Server Registration screen.
			
Possible cause 2
			The control port number is different than that of Base station’s Remote Utility.
			
Solution
q Check the Base station’s control port number*. (p. 15)
			
w Enter the correct port number in the Control Port (UDP) field in the Sever Registration screen.
				 * The default number is “50001.”

❍ “LOGON NG” is displayed under the Base station name
		
Possible cause
			
The user ID or password is different than that of the Base station’s Remote Utility.
			
Solution
q Check the Remote station information registered in the Remote Utility. (p. 16)
			
w Enter the correct user ID and password into the User ID and Password fields in the
“LOGON NG”
Sever Registration screen.

1
2
3
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❍ “DISABLED” is displayed under the Base station name
		
Possible cause
			
The Base station is set to “Disable,” to inhibit connecting to it.
			
Solution
	Enable the Base station by removing a check mark from the Disable box in the Sever
Registration screen.
“DISABLED”

NOTE:
If you could not solve the problem after trying these solutions, check the following on the Base station side.
• Is the Remote Utility activated?
• Is the Remote Utility added as an exception in the Firewall? (pp. 1 to 3)
• Is your Remote station information registered in the Remote Utility’s User List screen? (p. 16)

13
14
15
16
17
18
19
20
21
32

5

TROUBLESHOOTING

Problem: Cannot access a radio with the Remote Utility
The description in this part is based on the assumption that the connection to the Base station has succeeded
(“CONNECTING” is displayed under the Base station name).
❍ “BUSY” is displayed under the radio name
		
Possible cause
			Another user is currently operating the radio.
			
Solution
Wait for “BUSY” to disappear.
		
If you are operating as a Base station, or as an administrator Remote station, you
“BUSY”
can terminate a connection between another Remote station and a radio. (p. 20)
			
❍ “CONNECTING ERROR” is displayed under the radio name
		
Possible cause 1
			
Access to the selected radio is inhibited by the Base station.
			
Solution
	Allow the Remote station to access the radio with the Base station’s Remote Utility.
			
“CONNECTING (p. 18)
ERROR”

			
Possible cause 2
			
The virtual driver is not installed in the Remote station’s PC.
			
Solution
	Install the virtual driver in the Remote station’s PC. (See the RS-BA1 Preparations for
details.)
NOTE:
If you could not solve the problem after trying these solutions, check the following on the Base station side.
• Is the radio turned ON?
• Are the correct COM port number and audio device to which the radio is connected selected in the Radio Registration screen (Server Setting mode ➔ Radio List screen ➔ [Properties])?
• Is not the Base station directly accessing the radio using the Remote Controller, without having used the Remote Utility to connect to the radio?
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Problem: Cannot access a radio with the Remote Controller

 o access a radio with the Remote Controller, configure the connection settings in the Connect SetT
ting screen. (pp. 29, 30)
Click the Connect Setting icon (
) on the toolbar, or click “Connect Setting...” in the [Option] menu
to open the screen.
❍ When connecting to the radio through the network using the Remote Utility
		 Possible cause 1
		Connecting to the radio is unsuccessful using the Remote Utility.
		 Solution
Try again to connect to the radio in the Radio List screen (Radio Operation mode). (pp. 21, 24)
• “<<CONNECT>>” appears under the radio name when the connection has succeeded.
		 Possible cause 2
		In the CI-V field of the Remote Controller’s Connect Setting screen, the CI-V settings are different than
that of the Remote Utility.
		 Solution
In the Connect Setting screen, click [Search], and then select the correct radio in the Remote Utility
menu.
• The CI-V settings are automatically loaded from the Remote Utility.
NOTE:
If you could not solve the problem after trying these solutions, check the following on the Base station side.
• Are the same CI-V address and baud rate that are programmed into the radio set in the Radio
Registration screen (Server Setting mode ➔ Radio List screen ➔ [Properties])?
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❍ When directly accessing the radio without using the Remote Utility
		 Possible cause 1
		An incorrect COM port number is selected in the Remote Controller’s Connect Setting screen.
		 Solution
q Check the COM port to which the radio is connected, on your PC’s Device Manager.
		 w Select the correct COM port number in the COM Port menu in the Remote Controller’s Connect
Setting screen.

11

		 Possible cause 2
		The CI-V address or baud rate is different than that are programmed into a radio.
		 Solution
q Check the radio’s CI-V address and baud rate.
			 See the radio’s instruction manual to check them.
		 w Enter the radio’s correct CI-V address in the CI-V address (Radio) field, and select the radio’s correct baud rate in the Baud rate (bps) menu, in the Remote Controller’s Connect Setting screen.
			 If the radio’s baud rate is set to “Auto,” select “19200” in the Baud rate (bps) menu.
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Problem: Cannot properly control the radio with the Remote Controller
Possible cause 1
		 The same CI-V address is being used by a control software other than the Remote Controller.
		 Solution
S
 elect an address other than “E0” in the CI-V Address (RS-BA1) menu in the Remote Controller’s
Connect Setting screen. However, this solution does not always solve the problem.
Possible cause 2
		 In the Remote Controller’s Connect Setting screen, a different model name is selected for the radio
that you attempt to control.
		 Solution
S
 elect a proper model name in the Model menu in the Connect Setting screen.
NOTE:
If you could not solve the problem after trying the solution, check the following on the Base station side.
• Is there any radio that has the same CI-V address in the system?
Problem: The received audio cannot be heard
The description in this part is based on the assumption that the connection to the radio has succeeded (“<<CONNECT>>” is displayed under the radio name).
Possible cause 1
		 The speaker is not turned ON, or the volume level is too low.
		 Solution
T
 urn ON the speaker, or adjust the volume level.
Possible cause 2
		 A
 n earphone or other device is connected to the computer in place of the speaker.
		 Solution
D
 isconnect the device.
Possible cause 3
		 T
 he appropriate audio device is not selected in the Remote Utility.
		 Solution
Select the appropriate audio device in the AF Output Device menu in the Connection Setting screen
(Radio Operation mode ➔ Radio List screen ➔ [Settings]). (pp. 21, 25)
		 If you connect a new USB audio device to your PC, the audio device which is selected as a default
device in your PC can be changed. If you select “Default Device” in the AF Output Device menu,
please keep that in mind.
Possible cause 4
		 T
 he volume level of the audio device is set to too low on your PC.
		 Solution
Adjust the volume level of the audio device. (pp. 4 to 6)
		 Windows 7 and Windows Vista have the Volume Mixer function that can adjust each application’s
audio level. If you use Windows 7 or Windows Vista, please check that the Remote Utility or the
control software is not muted, or set to an appropriate volume level.
Possible cause 5
		 A
 udio output is disabled in the Remote Utility.
		 Solution
Insert a check mark in the AF Transmission box in the Connection Setting screen (Radio Operation
mode ➔ Radio List screen ➔ [Settings]).

35

TROUBLESHOOTING

5

Possible cause 6
		 T
 he volume level is too low, or the mute is turned ON in the Remote Utility.
		 Solution
A
 djust the volume level in the Received Audio Adjustment screen (Radio Operation mode ➔ Radio
List screen ➔ [AF]). (p. 26)
NOTE:
If you could not solve the problem after trying these solutions, check the following on the Base station side.
• Is the volume level of the audio device to which the radio is connected set to an appropriate level?
• Is there a check mark in the AF - Use box in the Radio Registration screen (Server Setting mode ➔ Radio List
screen ➔ [Properties])?

Problem: The transmit audio cannot be output
- The description in this part is based on the assumption that the connection to the radio has succeeded (“<<CONNECT>>” is displayed under the radio name).
- To check the Remote station’s transmit IF signals, use the Transmit Monitor function with the Base station’s Remote Utility, or place a receiver near the Remote station’s or Base station’s PC.
Possible cause 1
		 The microphone is not turned ON, or the input level is too low.
		 Solution
T
 urn the microphone ON and adjust the input level.
Possible cause 2
		 T
 he appropriate audio device is not selected in the Remote Utility.
		 Solution
S
 elect the appropriate audio device in the MOD Input Device menu in the Connection Setting screen
(Radio Operation mode ➔ Radio List screen ➔ [Settings]). (pp. 21, 25)
		 If you connect a new USB audio device to your PC, the audio device which is selected as a default
device in your PC can be changed. If you select “Default Device” in the MOD Input Device menu,
please keep that in mind.
Possible cause 3
		 The input level of the audio device is set to too low on your PC.
		 Solution
A
 djust the input level of the audio device. (pp. 4 to 6)
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Possible cause 4
		 A
 udio input is disabled in the Remote Utility.
		 Solution
Insert a check mark in the MOD Transmission box in the Connection Setting screen (Radio Operation mode ➔ Radio List screen ➔ [Settings]).
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Possible cause 5
		 T
 he input level is too low in the Remote Utility.
		 Solution
A
 djust the input level in the Transmit Audio Adjustment screen (Radio Operation mode ➔ Radio List
screen ➔ [MOD]). (p. 26)

15

Possible cause 6
		 An incorrect connector is selected in the Remote Controller.
		 Solution
S
 elect the proper radio’s connector which is connected to the Base station’s PC, in the MOD Select
(Remote ON) menu in the Remote Controller’s MIC SET screen. (p. 31)
NOTE:
If you could not solve the problem after trying these solutions, check the following on the Base station side.
• Is the input level of the audio device to which the radio is connected set to an appropriate level?
• Is there a check mark in the MOD - Use box in the Radio Registration screen (Server Setting mode ➔ Radio List
screen ➔ [Properties])?
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Problem: The received audio is interrupted
Possible cause 1
		 The network data transfer is too excessive.
		 Solution
S
 elect a lower sampling rate value in the Sample Rates menu, or a different codec in the Codecs
menu, in the Connect Settings screen (Radio Operation mode ➔ Radio List screen ➔ [Settings]).
		First, select the lowest value. If the received audio is not interrupted with the setting, try a higher value,
and adjust to an appropriate value.
Possible cause 2
		 T
 he capacity of the prebuffer is not enough.
		 Solution
Select a longer value in the Prebuffer (ms) field in the Connection Setting screen (Radio Operation
mode ➔ Radio List screen ➔ [Settings]).
		Select as short a value as possible, because longer prebuffers can cause a delay, and make it difficult
to adjust the audio level.
Possible cause 3
		 Y
 our PC is overloaded.
		 Solution 1
Shutdown other applications, if running.
		 Solution 2
Reduce the number of radios you are accessing with the Remote Utility.
NOTE:
• If you are accessing the radio through a network, removing a check mark from the Retransmission box in the
Connection Setting screen (Radio Operation mode ➔ Radio List screen ➔ [Settings]) can solve the problem.
• You can check the simplified packet round trip time, and the average packet loss in the Remote Utility’s Server
List screen.

Packet round trip
time
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Average packet loss
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